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Introduction
The Interactive Knee is a complete and accurate anatomical reference - in three dimensions.    The CD-
ROM goes beyond any traditional textbook.    Users can rotate the 3D model on the computer screen, 
peel away layers, and label any visible feature.    A broad selection of anatomical, clinical, and radiological 
text accompanies the 3D presentation.

Interactive Knee is an essential tool for use in teaching, in the clinic, and in presentations.    As a patient 
information resource, the CD-ROM has unmatched power to convey anatomical features in a 
comprehensible format. As a teaching tool, its unique graphic content provides a new and powerful 
educational resource.

The program splits the disk into five distinct sections, allowing the user quick and easy access to each 
part.    To swap between each section on the disk, click on the named tabs along the top of the main 
interface.    You can also "undock" each section by dragging the tab off the main interface.    This allows 
you to view two or more sections simultaneously, for quick cross-referencing between each part.

Anatomy Section

Contents Section

MRI Section

Quiz Section

Test Section



Anatomy Section
This is the main section of the disk, showing various views of the 3D Model alongside the related text.    
There are two main views of the model as well as numerous additional views showing dermatome maps, 
cutaneous innervation and neurovascular distribution.

You can change the view of the model by using the drop-down menu underneath the main image window.

Labeling the 3D Model

Rotation Controls

Layer Controller

Zoom Functions

Text



Labeling the 3D Model
Every visible anatomical structure on the 3D model can be labeled. 

Simply use the mouse pointer to click on the structure of interest and the selected structure will be 
highlighted in a cross-hatch pattern. 

Simultaneously, the name of the selected anatomical structure will appear in the box to the right of the 
model along with its accompanying text.

If you want to track a particular structure between frames, select the Refresh Image Labels When 
Changing View option in the Preferences (Select Preferences from the Edit menu).



Rotation Controls

The two arrow buttons allow rotation of the displayed model.    A single click on either arrow rotates the 
model by 10 degrees. The direction of the arrow indicates the direction that the model will rotate.

The model can also be set to rotate continuously by clicking on the outer two rotate buttons. To stop 
continuous rotation, either click again on either central arrow button, or click on the model.



Layer Controller

The layer control allows addition and subtraction of layers of anatomy. The main model contains 18 
layers.    
Layer 1 displays the bones with bone regions marked in red. Layer 2 displays muscle attachments, 
colored in blue.
Thereafter, layers of anatomy are superimposed until the surface anatomy layer is reached at layer 18.

Use the up and down buttons on the slider to add and subtract layers.    To jump several layers, either 
drag the bar along    the scroller between the arrows or click on the background of the scroller.

The Deep and Superficial buttons allow the user to jump immediately to layer 1 or layer 18 respectively.



Zoom Controls
Any 3D model image displayed in the image window can be labeled, zoomed, and moved around by 
toggling the associated buttons detailed below.

To zoom in on the model, select the zoom button. To zoom out, simply select it again. 

To move a zoomed image; place the cursor in the image window, click and hold the left mouse button, 
and drag the image around.

To label an image at any time, click on the label button. 



Text
Every anatomical structure modeled in the Interactive Knee has related anatomical text. This text appears
in the text box when a structure is selected either from the Contents or by clicking on the 3D Model. In 
addition, text will appear for an anatomical structure if it is highlighted on a MRI slice within the MRI 
window.

If a piece of displayed text is longer than the text box, the scroll bar can be used to move the text up and 
down. Alternatively, the mouse can be used to grab the text and move it up and down.

Clicking and holding the left mouse button grabs the text which can then be moved. When grabbing the 
text the cursor changes to a grabbing hand.

Within the text are a number of red words. These text hotspots link to a wide range of slide and video 
material.    When the cursor is positioned over one of the text hotspots it changes to pointing hand.



Next and Previous Buttons

The Previous and Next buttons step you through the list of all the anatomical structures on the 3D model. 
The entire text contents can be browsed simply by going through each individual text topic. These buttons
also remember which type of text you are currently viewing and will automatically jump straight to that 
particular section within each article.



Text HotSpots
There are numerous hot-spots within the text.    These show up as red words and provide a link to related 
material.

Click once on the red word and a pop-up appears giving a list of the related material. 

Select an item from this list, or cancel the pop-up by clicking anywhere else on the screen.

The type of information presented in the pop-up selection can be identified by the type of icon 
accompanying the title:-

Slide
MRI Slide/Sequence
Video Clip
Text Link

When selecting a text hot-spot from a piece of text; the slide or video will appear in it’s own floating 
window.    You can change the preferences to make each new slide or video be viewed in the same 
floating window or in a new window for each image.



Slide and Video Window
A number of controls are provided to assist in detailed viewing and labeling.

Labels: Move the mouse over the image and click whenever the pointer changes shape. The label will be
outlined and its name appear in the caption box beneath.

Move: Click and drag to move the image around the screen.

Zoom:    Left-Mouse Button click - Zoom In;      Right-Mouse Button click - Zoom Out

Reset Zoom: This resizes the image to fit the size of the labeling window.

Label List: This buttons shows a complete list of labels on each image.

Video controls: These controls display on annotated images which may be played as a video sequence. 
From left to right the controls are: start of movie, previous frame, play movie, pause movie, next frame & 
end of movie.

Other movies are displayed with standard Windows Media player video controls.



Contents Section
The Contents window pulls up the main navigation tool for the disk.    Within this window the user can 
toggle between the three sections by selecting either the Search, Browse or Context tabs in the top 
control bar.    The working of each of these sections is explained below.

The Contents window can be undocked from the main interface to allow the user to jump quickly between 
different parts of the contents. To keep the undocked Contents window from disappearing behind the 
main interface when you choose an item from it, click on the Pin button.

Search

Browse

The buttons in the bottom left corner of the window change how the results are displayed.

 Thumbnails only

 Titles and Thumbnails

 Titles only



Search
This function allows the user to search for any label or topic title contained within the disk.The Search can
be set to one of the following parameters allowing the user to search the entire content of the disk or just 
a specified type of resource:

Everything
Anatomy Text
Knee MR
Axial MR of the cadaver knee
Dissection Slides
MR Slides
Biomechanical Videos

Type in a word or short phrase to search for, select a choice of category from the above list and click on 
the Find button. Search results are displayed in the window below. 

The Search works using a boolean AND; in other words, it will look for all the separate terms you specify. 
If it returns no results, try reducing the number of search terms. For instance, if "dorsal third ligament" 
does not find the required item, try just "dor lig". 

To view an entry from the list; either double click on the entry or click on it once followed by the OK button.



Browse
These options allow you to browse the entire disk in alphabetical order.    Each section of the disk is 
displayed within its own folder, much like the Windows file system.    Simply double-click on each folder to 
open it and view its contents.

Use the Close Folder icon to close each folder;
Use the Top Level icon to go back to the start again.

Once you have chosen any item the Links button becomes available. This allow you to see every article 
that has links to that particular image or video.    The links for each image and video appears under the 
Context tab.



MRI Section
This section shows three orthogonal views through the Knee 3D Model, alongside a complete set of axial,
coronal and sagittal MRI slice data.

This button shows the Axial view through the knee.

This button show the Sagittal view through the knee.

This button shows the Coronal view through the knee.

The left and right arrows at the lower left of the MRI screen can be used to move forward or backwards 
through the MRI slices. As this is done the sliced 3D model will automatically update, keeping in step. In 
this way the user can compare related axial, coronal, or sagittal MRI data with the sliced 3D model data. 
You can also either click and hold, or press Ctrl+click on either of these buttons to play the MRI set as a 
continuous sequence. To stop this continuous play, release the button or click on the MRI image.

This button shows the equivalent 3D model slice for the current MRI image.

This button finds the equivalent MRI image for the current 3D model view.

Labeling the MRI slices
The majority of anatomical structures on the MRI slices can be labeled by clicking on them. This will 
highlight the structure on the MRI and on the sliced model, if visible. In addition, the text will update to 
display narrative related to the selected structure. 

The MRI window is also undockable and hence can be dragged off and resized.



Quiz Section
This section allows you to test yourself on your knowledge of the Knee.    You can set the quiz to test you 
on different layers, different types of question and two different grades of difficulty. The hardest grade of 
question requires you to navigate to an appropriate image if asked to locate a structure.

After setting up the quiz and choosing the total number of questions you wish to face, press the Start Quiz
button and away you go.

A score is kept of all your correct and incorrect answer and a summary of this is shown at the end.

There is an option to do a Preset Quiz, using a pre-built Quiz file. At present there is only a simple demo 
quiz file on this CD-Rom.You will be able to download a Quiz Builder program from the Primal Pictures 
website shortly.



Slidebox
The Slidebox function enables you to create, save and play back a series of images or video clips for the 
purposes of teaching and revision. To open the Slidebox click the Open option in the Slidebox menu.

The Slidebox is composed of three sections: the editor, the viewer and the slideshow. The tabs along the 
top of the Slidebox window allow you to toggle between these three sections.

Slidebox Editor

Slidebox Viewer

Slide Show



Slidebox Editor
Any image or video clip display in the main interface can be added to the Editor. This can be 
accomplished in two ways:

1. Use the Add Image to Slidebox option from the Slidebox menu.    This will add the currently visible 
image into the Slidebox, along with any label that’s highlighted on it.

2. To add an image or video clip from the main interface, simply click on the Add button on the left of the 
Editor window.    This will add whatever the last focused image into the Slidebox, whether it was a movie, 
a 3D model slide or a MRI image.

You can only add new items into the Slidebox when it is in the Editor mode.

A number of controls within the Slidebox Editor mode allow you to reorder, duplicate and delete images in 
the Slidebox.

Select an image and use these buttons to change its position in the slidebox.    You can alternatively use 
drag and drop functions to change the order of the images in the slidebox. Use CTRL and SHIFT to alter 
the selection.

This button will delete the selected image from the slidebox.

This button will make a copy of the selected image into the slidebox.

These two buttons along the bottom of the window allow you to choose how you wish to display the 
selected images in the Editor.

Thumbnails only

Thumbnails and title

Slides within the Editor can be viewed either in the Slidebox Viewer or the Slide Show 



Slidebox Viewer
The Slidebox Viewer displays the slides in the order determined within the Editor.    A number of controls 
are included in the Viewer. 

Labels: Move the mouse over the image and click whenever the pointer changes shape. The label will be 
outlined and its name appear in the caption box beneath.

Move: Click and drag to move the image around the screen.

Zoom:    Left-Mouse Button click - Zoom In; Right-Mouse Button click - Zoom Out

Reset Zoom: This resizes the image to fit the size of the labeling window.

Labels: Displays all the labels on each image in a floating window. Select a label from the list and the 
related region will be highlighted on the image.

These buttons allow the previous or next slide to be displayed



Slide Show
The Slide Show mode of the Slidebox displays the selected slides in a full screen format against a black 
background.

Labels appear below the image displayed. The order set in the Editor determines the order in which the 
slides and video clips are played. There are several options available in the Slide Show. To display the 
next slide in the sequence, use the right cursor key; to select a previous slide use the left cursor key.

To close the Slideshow and return to the Editor mode, press ESC or click on the Close Window button in 
the top right-hand corner.



Slidebox Menu
The Slidebox has its own Windows Menu Bar containing three menu options:

File
Print Image Print the current visible image.
Exit Closes the current Slidebox

Edit
Copy Image Copy the current visible image to the computer's Clipboard.
Save Image to Disk Save the current image onto your harddisk in bitmap format.

Action
Run Slidebox View the Slidebox
New Slidebox Creates a new Slidebox
Merge Slidebox Merges two or more pre-saved Slideboxes
Load Slidebox Opens an existing Slidebox
Save Slidebox Saves a current Slidebox to disk



Knee Menus
Interactive Knee has five menus: File, Edit, Slidebox, Windows and Help.

File Menu
Edit Menu
Slidebox Menu
Window Menu
Help Menu



File Menu
Menu Option Description

Print Setup Use Print Setup on the File Menu to set your printing preferences such as which 
printer, number of copies, etc.

Print Image Print either the 3D Model or the MRI image. The second option is only available when 
the MRI section is visible.

Print Text To print the text for a particular structure - locate and click on it, then select Print Text 
from the File menu.

Exit Exit Interactive Knee.



Edit Menu
Using the Edit Menu you can copy text or images to the Clipboard, you can then paste the article or 
image into a word processor or presentation program, or you can set the program preferences

Menu Option Description

Copy Image This will copy either the 3D Model or the MRI image to the computer's clipboard.
The second option is only available when the MRI section is viewable.

Copy Text    To copy the text for a particular structure - locate and click on it, then select 
Copy Text from the Edit menu.

Save Image to Disk This will save a copy of either the 3D Model or the MRI image to your harddisk. 
The image will be saved as a Bitmap and you can then use it in any image 
manipulation program, for instance Paint.

Preferences The Preferences panel allows program settings to be modified.



Preferences
Button Sounds On/Off Turn the button sounds on and off

One Labeling Window Turn this off and you will get multiple windows to view images in.

Show Image Tools This will remove the zoom and move controls from the interface.

Refresh Image Labels When Changing View
This option will ensure the chosen label will remain highlighted as you
alter the view of the model

Show Pop-up Image Labels This option brings up a pop-up label identifying the underlying 
anatomy as the mouse moves over the 3D model.

Short Timer Interval Rotates the 3D model on a "fast" setting.

In addition, the preferences menu allows you to determine the colors of the label cross-hatching for 
anatomical structures on the 3D model.



Slidebox Menu
A Slidebox function has been included in Interactive Knee enabling you to create, save and play back 
series of images for the purposes of teaching and revision. 

Slidebox files may be saved to disk for later use, but will only work in conjunction with the program. 

The Slidebox menu contains the following options:

Add to Slidebox... This will add either the current 3D Model or the MRI image to the Slidebox. It 
also adds any highlighted label to the Slidebox too.

Open Slidebox Editor... Opens the Slidebox Editor.(see the Slidebox Editor)



Windows Menu
Each of the five main sections have their own windows which can be docked and undocked from the main
interface. You can also click and drag each separate window off the main interface by dragging the tab 
above or below the docked position. To redock them, either use this menu option again or use the Close 
Window button.

The Windows menu has the following options:

Undock Anatomy... Undock the Anatomy section from the main interface.

Undock Contents... Undock the Contents window from the main interface.

Undock MRI... Undock the MRI section from the main interface.

Undock Axial slice... Undock the separate MRI window from the MRI section.

Undock Quiz... Undock the Quiz section from the main interface.

Undock Test... Undock the Mulitple choice test section from the main interface.



Help Menu
Interactive Knee Shows this Help File.

About... Program information and version number.
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Technical Specifications
The Interactive Knee CD-ROM for PC has the following minimum requirements: 

PC:
Pentium or equivalent processor;
32 MB Ram; 16-bit or Hi Color display.
Windows 95, 98, 2000.or NT 4.0

Mac:
Any Power Macintosh or equivalent;
20 MB free Ram; thousands of color display;
System 7.1;
Quicktime 2.5 with MPEG decompressor installed.
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Primal Pictures Ltd.
1st Floor
Tennyson House
159-163 Great Portland Street
London W1N 5FD
U.K.

Sales and Marketing
E-mail: email@primalpictures.com
Telephone: +44 (0)20 7637 1010
Fax: +44 (0)20 7636 7776

Technical Support 
E-mail: support@primalpictures.com
Telephone: +44 (0)20 7637 1010
Fax: +44 (0)20 7636 7776

Website www.primalpictures.com



Test - Multiple Choice Questions
This section of the disk allows you to test yourself using standard multiple choice questions.

This button starts the multiple-choice test. The questions appear in the form of an initial statement, 
followed by up to five optional statements    You must mark which statements are true and which are false.

At any time during the test you can choose to have your answers checked.

Use these three buttons to mark an answer true, false or pass. If you cannot decide; you can select P 
(pass). This allows you to miss the question without losing a mark. If you do not choose any of the three 
options and answer the next question instead, the missed question will be be deemed as answered 
incorrectly.

There is an option to Load an external mcq test file, but this CD-Rom only provides a simple example of 
this. More complex multiple choice quizzes will be available later, as well as a Multiple Choice Quiz 
Builder program.






